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Chapter	1	–	Create	an	Alignment	
  

1) Determine the geographic coordinate system and make a note of it. 

2) Create a 2D dgn and name the file, 0510077 Alignment.dgn, using IDOTBridge-2D.dgn as the seed file. 

3) In the “Search Ribbon” in the upper-right of your screen, select and start typing “coordinate”.  Select 

“Coordinate System”. 

 
4) Select the “From Library” icon. 

 

 
 

5) From the list, select “IL83/2011-EF” at the bottom of the Favorites list and pick “OK”. 

 

 
 

6) Save Settings. 
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7) From the Home tab, select “References” from the “Attach Tools”. 

 

 
 

8) Map to the file D774443-align.dgn, having the Attachment Method set to “Coincident World” and select 

“Open”. 

 
 

Note:  We will be re-creating the tangent of the bottom horizontal alignment from Station 1056+61.30 to Sta. 

1082+21.58. 

 

9) Ensure that AccuSnap is on. 
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10) Ensure that Civil AccuDraw is toggled on. 

 

 
 

11) In the Feature Definition Toggle Bar, choose the “GE_Pr_Centerline” feature definition. 

 

 
 

12) Under the OpenBridge Modeler workflow, select the “Civil” tab. 

 

 
 

13) From the “Lines” drop-down in the “Horizontal” tool group, pick “Line Between Points” 
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14) Snap to the point at Sta. 1056+61.30 and Accept. 

 

 
 

15) Snap to the point at Sta. 1082+21.58, Accept, then Reset. 

 

 
 

16) Turn off the attached alignment Reference File. 
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17) From the Horizontal Alignment group of the Civil tab, select the “Modify” dropdown, then “Start Station”. 

 
 

18) In the dialog box, toggle “Start Distance” and enter the values shown below. 

 

 
 

19) Select the horizontal alignment element near the left side (West side) and then accept both the Start Distance as 

well as the Start Station. 

 

20) From the “Reports and Drawings” tab, make sure the “Annotation Scale” toggle is on, then pick a scale, such as 

“1”=50’”.   

 

 
 

21) From the “Element Annotation” dropdown, select “Annotate Element”. 

 

 
 

22) Select the alignment and reset. 
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At this point, you should see the centerline with stationing every 100 feet as below: 

 

 
The horizontal alignment is now complete.  To create the profile grade, the tools under the “Vertical” group will be 

used within the “Civil” tab. 

 

23) Using the Selection tool, select your horizontal alignment, move your cursor away from it, and then hover over 

the horizontal alignment (bump the mouse). 

 

24) Select “Open Profile Model” when the pop-up appears. 
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25) Open and select a new view window.  The screen will change to show stations and elevations as below: 

 

 
 

26) Select “Profile Curve Between Points” from the “Vertical” drop-down within the “Civil” tab. 
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27) Make sure that the “Placement Method” is set to “Start/End/Vpi”, the “Vertical Curve Type” is set to 

“Parabola”.  The “Feature Definition” should still be set to “GE_Pr_Centerline”. 

 

 
 

28) Left-Click to accept the “Placement Method”. 

 

29) Key-in Station 1066+25.00 for the “Start” (VPC) and hit “Enter”. 

 

30) Enter the “Z” elevation of 460.88 and hit “Enter”. 

 

31) Data point to accept. 

 

 
  

32) Key in Station 1074+75.00 for the “End” (VPT) and hit “Enter”. 
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33) Enter the “Z” elevation of 451.98 and hit “Enter”. 

 

34) Data point to accept.  

  

 
 

35) Key in Station 1070+50.00 for the “VPI Point” and hit “Enter”. 

36) Enter the “Z” elevation of 451.95 and hit “Enter”. 

37) Data point to accept. 

38) Reset to exit command. 

 

 
 

39) Select the profile element. 
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40) Bump the mouse and pick the “Set as Active Profile” button. 

 

 
 

41) Save settings. 
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Chapter	2	–	Create	Bridge/Support	Lines	
1) Create a 3D dgn and name it “0510077 OBM Bridge.dgn”. 

2) Select the Geographic Coordinate System in the same way as the previous exercise. 

3) Reference the previously created alignment file, “0510077 Alignment.dgn” with the “Attachment Method” set 

to “Coincident World”. 

4) Save Settings. 

5) In the “Reports and Drawings” tab, change the “Drawing Scale” to 1”=50’ so the stationing can be read. 

6) In the “Bridge Setup” group of commands, select “Add Bridge”. 

 

7) Fill out the “Add Bridge” dialog as shown below:  (Make sure that you pick the proper “Bridge Type”.  You 

cannot fix this later.  You would have to start your bridge over if you chose the wrong one). 

 

8) Select the horizontal alignment, accepting the choices until the pop-up disappears.  At this point, the bridge data 

has been added. 
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9) This can be verified by opening the “Explorer” in the “Home” tab of the “OpenBridge Modeler” workflow. 

 

10) Expand the “Bridge Model” under the “OpenBridge Model” dropdown to verify that the bridge has been added. 

	



Illinois Department of Transportation 
Technology Policy and Support – CADD Support Unit 

 

Page 13 of 149 OpenBridge Modeler CONNECT Edition 
Chapter 2 – Create Bridge/Support Lines – EXERCISES 

 

11) In the “SupportLine” group of the “OpenBridge Modeler” workflow, click the “Place” dropdown and select 

“Multi”. 

 

12) Fill out the dialog and set the toggles as shown below: 

 

13) Accept the popups at the cursor location until the “Place Multi SupportLines” dialog appears, showing the initial 

support lines and other data related to them. 

14) Edit the data in that table so that the stations and span lengths appear as below (Note that changing any values 

affects others).  The support lines may be left as “SupportLine1, 2, 3” etc. or they can be given more meaningful 

names, such as “West Abutment”, “Pier 1”, “Pier 2”, “East Abutment.” 
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15) Select “OK” and reset to clear the command.  The support lines should appear as shown below. 
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Chapter	3	–	Modify	Templates	
  Templates used for several of our bridge components have been created.  At some point after beginning a project, you 

will need to copy, create, or modify templates for things such as the deck, barriers, piers, stiffeners, cross frames 

(diaphragms), etc…  Those can be found under the “Utilities” tab of the “OpenBridge Modeler” workflow. 

 

Our IDOTCAD configuration includes some that have been modified exclusively for IDOT.  The first that we will look at is 

the deck templates. 

1) Select “Decks” within the “Libraries” group of the “Utilities” tab: 

 

2) Expand the “Standard Templates” and the “Illinois DOT” folders. 
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3) Right-Click on “Standard Templates” and “Add Category”. 

 

4) Give the category a name, such as “051-0077” and select “OK”. 

 

5) Right-Click on “Beam Slab” under “Illinois DOT” and select “Copy”. 
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6) Left-Click, drag, and drop “Beam Slab-Copy” to the Category “051-0077” and release. 

7) Right-Click on the template that we just moved and select “Rename”. 

 

8) Give the template a new name, such as “Superstructure”. 

9) For this bridge, we need to change both the left and right shoulder widths from 8 ft to 6 ft.  To do this, you can 

use the view controls in the drawing window and zoom in to determine the node name for the left shoulder.  It 

should be point “P_20”. 

 

10) In the “Point Details” tab in the lower left, select the “P_20” row. 
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Select the Value of “-8.000” under the Horizontal Constraint and change to “-6.000” and select “Save”. 

 

11) Do the same for the Right shoulder width and give it a value of positive “6.000” and click “Save” again.  It should 

be point “P_2”. 

12) The only other thing that needs to be modified for this template is the bottom of the deck at the edge of the 

fascia beam flanges.  Because of issues in OBM generating a proper fillet while using an exact dimension, a 

slightly smaller value will be used for the “LT Edge Width” and the “RT Edge Width” horizontal constraints.  

Verify that “P_14” is the correct point for the left side by zooming into the left edge of deck. 
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13) Now change the “P_14” value to “2.27” ft and select “Save”. 

 

14) Zoom in to the right side of the deck to determine the point.  It should be “P_8”. 
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15) Change “P_8” value to “-2.270” and select “Save”. 

 

16) Close the Template Creation dialog. 
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Chapter	4	–	Place	Deck	&	Barriers	
1) From within 0510077 OBM Deck.dgn, under the “Home” tab and within the “Superstructure” group, select 

“Place Deck”. 

 

2) Fill out the “Place Deck” dialog as shown: 

 

  



Illinois Department of Transportation 
Technology Policy and Support – CADD Support Unit 

 

OpenBridge Modeler CONNECT Edition 
Chapter 4 – Place Deck & Barriers – EXERCISES 

Page 22 of 149 

 

3) For the “Deck Material”, select the “…” in the “Material Group”. 

 
 

4) From the “Concrete” tab, select the “Concrete Superstructure (4 ksi)”, then “Select”. 

 
 

5) Select the “…” to the right of the field for “Template Name”. 
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6) Expand the template folder for 051-0077 and highlight the “Superstructure” template that we created earlier.  

Click on “Select” in the lower right corner of the dialog. 

 

7) Follow the on-screen prompts, the first being, “Seclect 1st Deck Boundary (SupportLine)” and left-click on the 

1070+85.13 Support Line. 
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8) Follow the next prompt, “Select 2nd Deck Boundary (SupportLine)”. 

 

9) Accept “No” for “Deck:Add Constraints”. 

 

10) The deck has now been created one foot from the support lines which represent the back of the abutments. 
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11) From within ‘0510077 OBM Barrier.dgn”, select “Place Barrier” from the “Accessory” group at the top right of 

your screen. 

 

12) Fill out fields as shown below. 
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13) As was done for the Place Deck command, select “…” in the “Material” group. 

 
 

14) From the “Concrete” tab, select the “Concrete Superstructure (4 ksi)”, then “Select”. 

 
 

15) Select “…” to select the “Template Name”. 
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16) In the “Template Selection” dialog box, expand “Barriers” and “Illinois” 

17) Select “39” Constant Slope Parapet LT” and “Select”. 

 

18) Select the “Candidate”.  In other words, select anywhere on the deck solid. 

19) Right click, then left click on any point on screen. 

20) Pick “Select Guideline from List”. 

 

21) Zoom in to find the point that represents the curb line.  In this case it is “P_20”.  (You can change the size of the 

text to make it easier to see where the points are using the controls at the top of the first “Path Selection” 

dialog). 
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Select point “P_20” in the table and then “OK”. 

 

22) Select “OK” in the “Path Selection” dialog. 

 

  



Illinois Department of Transportation 
Technology Policy and Support – CADD Support Unit 

 

Page 29 of 149 OpenBridge Modeler CONNECT Edition 
Chapter 4 – Place Deck & Barriers – EXERCISES 

 

23) Rotate the plan view to make sure that the barrier has been placed. 

 

 

 

24) Repeat the procedure for the right side using the “39” Constant Slope Parapet RT” template at point “P_2”. 
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Chapter	5	–	Place	Beams	
1) Click on “Beam Layout” within the “Superstructure” group. 

 

2) Select the first, then the last support line, then accept. 

 

3) In the “Beam Layout” dialog box, change the “Placement Method” to “Continuous”. 

 

4) Using the arrows in the field for “Number of Beams”, increase the value to “6”. 

 

5) Change the “Edge Distance” value to “2.75”, toggle “Equal Edge Distance” on, and click on “Apply”. 
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6) Change the “SL Offset” to “15” (This is the distance from the back of the abutment to the beginning of the beam 

in inches). 

 

7) Make sure that your values appear as shown above and select “Validate”.  This temporarily shows where the 

beam lines would be given the entered values.  Use the zoom controls to make sure that it looks correct. 
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8) If satisfied, click on “Save”. 

 

 

9) From the “Home” within the “Superstructure” group, select “Place Beam”. 
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10) Ensure that the settings match the below, then select and accept the beam group. 

 

11) From the resultant “Beam Definition” dialog box, ensure that the “Beam Type” is set to “Rolled Shapes” and the 

Section is set to “Beam Template” 

 

12) Change the “Beam Minimum Haunch” from “0.000” to “1.74”.  (The value that OBM wants here is the physical 

haunch dimension plus the flange thickness). 

 

13) Click on the “Template” dropdown for the rolled shapes and select “W33x118”. 
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14) Select the “Material” by clicking in the field and selecting “Rolled Wide Flange, W30 and Larger, Grade 50”. 

 

15) Toggle “Apply to All Beams” in the lower left corner. 

 

16) Select “OK”. 



 

 

 



Illinois Department of Transportation 
Technology Policy and Support – CADD Support Unit 

 

Page 35 of 149 OpenBridge Modeler CONNECT Edition 
Chapter 6 – Place Diaphragms – EXERCISES 

 

Chapter	6	–Place	Diaphragms	
  Before placement of the diaphragms, the templates for the bearing stiffeners, connection plates, and cross frames 

(diaphragms) need to be created/modified.  Updating them in that order is as follows: 

1) From within the “Libraries” group under the “Utilities” tab, click on “Stiffeners”. 

 

2) Add a new stiffener (connection plate) or copy an existing one, modifying the contents as below: 

 

3) Save the changes. 

4) Open the Stiffeners Library again. 
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5) Add a new bearing stiffener or copy an existing one, modifying the contents as below: 

 

6) Save the changes. 

7) From within the “Libraries” group under the “Utilities” tab, click on “Cross Frames”. 

 

8) Change “Beam Type” from “Concrete” to “Steel” by clicking on the “Steel” toggle in the upper left-hand corner 

of the “Cross Frame Library” dialog. 
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9) Add a new interior diaphragm or copy an existing one.  Name it, “My IDOT Interior Diaphragm Gr 36 for 

W33x118.”  Modify the contents as shown  below: 
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10) Click on “Connection Plates” within the same dialog and turn off the “Top Left” and “Top Right” connection 

plate toggles as show below: 

 

11) Click on “Save”. 

12) From the “Home” tab, within the “Superstructure” group, select “Place Cross Frames”. 

 

13) Ensure that the Feature Definition is set to “Cross-Frame" 
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14)  Select “Beam Group” and accept. 

 

15) Click on “Add” in the “Cross-Frame Placement” dialog box.  
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16) You will add 13 rows to the table. 

17) Edit the row content to the values shown below: 
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18) With “Beam-1-Beam-2” selected, select “Copy”. 

 

19) Click on “Select All”, then “Copy By Ratio”. 
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20) Select “Validate” at the bottom of the dialog. 

 

21) Select “Save”. 

 

 

  



Illinois Department of Transportation 
Technology Policy and Support – CADD Support Unit 

 

Page 43 of 149 OpenBridge Modeler CONNECT Edition 
Chapter 6 – Place Diaphragms – EXERCISES 

 

 

22) From the “Home” tab, within the “Superstructure” group, select “Place Stiffeners”. 

 

23) Select the Beam Group again and click “Yes”. 

 

24) At this point, the “Place Stiffeners” dialog pops up with most of the data greyed out, indicating that it cannot be 

changed. 
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25) With the “Beam-1” row selected, add four new rows and edit as shown below.  The added data representing the 

bearing stiffeners for the abutments will appear in black text. 

 

26) You will need to copy the four new stiffener locations to the other beams by selecting the four rows and clicking 

“Copy”.	 
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27) Click on “Select All”, then “Copy by Ratio”. 

 

28) Verify that the added data is correct and exists for each beam by clicking “Validate”. 

29) If it appears correctly, then click “Save”. 

(The stiffeners must also be added outside the fascia beams at each pier). 

30) Select one of the abutment bearing stiffeners and go to “Properties”. 
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31) Click on “Edit”. 

 

32) Add two new rows for “Beam-1” and edit as shown below: 
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33) Select “Beam-6”. 

34) Add two rows and modify values as shown below: 

 
  

 
 

 
 
 

 

35) Select “Validate” at the bottom of the dialog, then “Save”. 
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Chapter	7	–Place	Shear	Studs	&	Field	Splices	
1)  Under the “Utilities” tab and within the “Libraries” group, select “Shear Studs”. 

 

2) Copy and edit one of the existing shear studs and name it “S3L-0.75x4.5”. 

 

3) Edit the values as shown below and click “Save”. 

 
 

3) Under the “Home” tab and within the “Superstructure” group, select “Place Shear Studs”. 
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4) Ensure that the Feature Definition is set to “Shear stud”. 

 

 

5) Select “Beam Group” and “Accept”. 
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6) Add five rows and edit as shown below: 

 
 
 

 

 
 

7) With “Beam-1” selected (and highlighted in grey as shown below), select “Copy”. 
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8) Pick “Select All”, then “Copy” 

 
 

9) “Validate”, then “Save”. 

 

 

  



Illinois Department of Transportation 
Technology Policy and Support – CADD Support Unit 

 

OpenBridge Modeler CONNECT Edition 
Chapter 7 – Place Shear Studs & Field Splices – EXERCISES 

Page 52 of 149 

 

10) Under the “Utilities” tab and within the “Libraries” group, select “Splices”. 

 

11) Copy the “Field Splice_0”. 

 
 

12) Name the template 0510077-Splice and edit the contents of the “General” tab as shown below: 
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13) In the “Web” tab, complete the fields as shown below: 

 

14) In the “Top Flange” tab, complete the fields as shown below: 
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15) At the bottom of the “Top Flange” tab, click the “Copy to Other Flange” button. 

 

16) Click on “Save”. 

 

17) Under the “Home” tab and within the “Superstructure” group, select “Place Field Splices”. 
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18) Select “Beam Group” and “Accept” (Ensure that the Feature Definition is set to “Field splice”). 

 

19) Edit the “Place Field Splices” dialog box with the data as shown below for the first splice location, then click on 

the “Add” button. 

 
 

20) The data is then added to the table as shown below: 
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21) Edit the “Place Field Splices” dialog box with the data as shown below for the second splice location, then click 

on the “Add” button. 

 
 

22) The data is then added to the table as shown below: 

 

23) Click on the “Validate” button at the bottom of the dialog to ensure that the splices appear as desired.  At this 

point, the two tentative splice locations will only show up on Beam 1. 
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24) Click on the “Copy” button. 

 
 

25) Click on “Select All” and then “Copy”. 

 

26) “Validate” and then “Save”. 
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27) The splices are then placed in the model. 

28) Change the Display Style and rotate to verify the splices if desired. 
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Chapter	8	–	Bearings	
  Bearings generally must be modeled using the 3D solids tools and converted from the default “Parametric Solids” to 

“Smart Solids”.  That is done with the tool in the “Modeling” workflow within the “Solids” tab. 

 

 

Once created, they must be placed in the “Bearings” folder under “Bridge Templates”.  This can be accomplished by 

importing the cells/models into the file “IDOT BearingLib.cel” or placing a new cell library file in the same location in the 

template library.  Once they are placed there, they will be available for OpenBridge Modeler to access. 

One additional note concerning the creation of bearings is that you would create them such that the origin of the cell is 

the top center of the upper-most plate of whatever bearing is being created.  The proper orientation for the bearing 

created can be deduced by opening and reviewing some of the pre-made bearings in the cell library. 

1) Under the “Home” tab and within the “Substructure” group, select “Place Bearing”. 
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2) Edit the values in the “Place Bearing” dialog box as shown below: 

 

3) Pick the “…” in the “Cell” row. 
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4) Choose the “IDOT-Integral 11.5 flange” and then “OK”. 

 

5) Select the first abutment support line. 
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6) Circles will appear at the tentative bearing locations. 

 

7) Right click to reset. 

8) Left click to accept the offset. 
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9) Select “Place Bearing” again, populating the dialog with the following data. 
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10) Select the last abutment support line. 

 

11) Right click to reset. 

12) Left click to accept the offset. 

13) Select “Place Bearing” again. 
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14) Edit the values in the “Place Bearing” dialog box as shown below, picking the “IDOT-Low Profile” bearing for the 

piers: 
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15) Select both pier support lines. 

 

16) Right click to reset. 

17) Left click to accept the offset. 

18) If desired, change your Display Style and rotate to view the placed bearings. 
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Chapter	9	–	Piers	
1) From the “Utilities” tab, select “Piers” in the “Libraries” group. 

 

2) Click on “Add” with “Multi Column” selected. 

 

3) Fill out the “Cap” dialog with the following information: 
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4) In the “Columns” tab of the same dialog, change the values as shown below: 

 

5) In the “Footings” tab of the same dialog, change the values as shown below: 
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6) In the “Piles” tab of the same dialog, change the values as shown below: 

 

7) Select “Pattern Layout” in the “Piles” tab. 
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8) Modify the values in the “Pile Pattern Layout” dialog as shown below: 

 

9) Select “Generate Piles” to update the drawing in the dialog. 

 

10) Select “OK” in the “Pile Pattern Layout” dialog. 

11) Select “OK” in the “Pier Templates” dialog. 

  



Illinois Department of Transportation 
Technology Policy and Support – CADD Support Unit 

 

Page 71 of 149 OpenBridge Modeler CONNECT Edition 
Chapter 9 – Piers – EXERCISES 

 

12) With “Pier 1” selected in the “Pier Templates” dialog, select “Copy”. 

 

13) Name the new template “Pier 2” and pick “OK”. 

 

14) With “Pier 2” selected, pick “Edit”. 
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15) In the “Columns” tab, modify the values as shown below: 

 

16) In the “Piles” tab, change the values as shown below: 
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17) Select “OK” in the “Pier Templates” dialog. 

18) Close the “Pier Templates” dialog. 

19) Return to the “Home” tab and select “Place Pier”. 

 

20) Edit the fields for the “Place Pier” dialog as shown below: 
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21) Click on the three dots next to the “Template Name” field. 

 
 

22) Select the just completed “Pier 1” for the “Template Name”, then “Select”. 
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23) Select the Pier 1 support line. 

 

24) Reset, then accept that there are no constraints. 
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25) In the same manner as we did for Pier 1 and the “Place Pier” command still active, select the “Pier 2” template 

for the “Template Name”. 

26) Select the Pier 2 support line. 

27) Reset, then accept that there are no Elevation Constraints. 

28) Reset once again to end the “Place Pier” command. 

 

The placed piers do not have the steps included.  While there is the ability to add steps during the bearing 

placement, the omission of the end steps does not appear to be possible using that tool.  There is also the lack of ability 

to control the step locations.  To work around this, placing the pier such that the top of the pier is at the low seat 

elevation seems to work the best.  The remaining steps can then be modeled using 3D solids tools.  Prior to doing this, 

the piers will likely need to be adjusted vertically.  The next steps show how to accomplish that. 

29) Rotate the view such that the top of the pier cap and the bottom of one of the exterior bearings can be clearly 

identified. 

30) Determine the bottom of bearing elevation by placing a sphere at the bottom of one of the exterior bearings 

and somewhere along the edge of the top of the pier cap. 

31) This is done from the “Modeling” group and the “Solids” tab. 
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32) Using the “Selection” tool, pick the bearing sphere, right click, then select “Properties”. 

 

33) With the “Sphere” element selected in the “Properties” dialog, expand the “Geometry” group, and then the 

“Center” entry as shown below: 
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34) In the same manner, find the elevation of the top of the pier as placed. 

 

35) In this instance, use the difference to determine the distance the pier needs to be moved up. 

36) Bottom of bearing (449.291) – top of pier cap (449.211) = 0.08 ft. 

37) Select the pier using the “Selection” tool. 

38) Bump the mouse and select “Properties”. 
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39) Select within the “Elevation Constraint” row to edit. 

 

40) Modify the values as shown below and pick “OK”: 

 

41) You can verify visually or by placing a new sphere and viewing the properties as before. 

42) Do the same for Pier 2. 

The last step for the piers is in adding the interior beam seats/steps.  Again, the piers have been placed such that the 

top of the cap is level and is the low-seat elevation for the exterior beams. 

We will use a different tool to isolate pier 1 so that it is the only thing shown. 

43) Using dynamic rotation, rotate the view so that you can see the Pier 1 cap, stem, and piles. 
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44) Using the selection tool, select the pier elements, right-click and hold, then select “Displayset Set”. 

 

45) Clear the selection and rotate to an isometric view. 

 

 

46) Draw a line on a level (such as “BR_Construction_Line”)from one face of the cap to the other at the middle. 
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47) Use the “Copy Parallel” tool, copy the line “6.667” ft twice in each direction (Type “T” after selecting the line.  

This rotates the AccuDraw compass to the Top view even though the view is still Isometric). 

 

48) Using the “Place Block” tool with the method set to “Rotated”, place four rectangles using the previously drawn 

reference lines to define the interior steps. 
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49) Using the “Extrude” tool in the “Modeling” workflow under the “Solids” tab, extrude the seats for beams 2 and 

5 a distance of “0.135” ft. 
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50) In the same manner, extrude the seats for beams 3 and 4 a distance of “0.229” ft. 

 

51) The steps can be combined with the pier cap at any point or left as separate solids.  They would be combined 

using the “Unite” command under the “Solids” tab of the “Modeling” workflow. (Note that if the steps are left 

as separate entities from the cap, you should change the level to “BR-OBM_Piers”). 

The step heights are different for Pier 2, so most of the previous steps will be repeated, but using slightly different 

values. 

52) Right-click and hold anywhere on the screen and pick “Displayset Clear”. 

 

53) Using the dynamic rotation tool, rotate the structure so that you can see the pier cap, stem, and piles without 

any other elements in front of or behind the pier. 

54) Select the Pier 2 elements, right click and hold, then select “DisplaySet Set”. 
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55) Return to an Isometric view. 

56) Draw a line on a level (such as “BR_Construction_Line”) from one face of the cap to the other at the middle. 

 

57) Use the “Copy Parallel” tool, copy the line “6.667” ft twice in each direction (Type “T” after selecting the line.  

This rotates the AccuDraw compass to the Top view even though the view is still Isometric). 
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58) Using the “Place Block” tool with the method set to “Rotated”, place four rectangles using the previously drawn 

reference lines to define the interior steps. 

 

59) Using the “Extrude” tool in the “Modeling” workflow under the “Solids” tab, extrude the seats for beams 2 and 

5 a distance of “0.125” ft. 
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60) In the same manner, extrude the seats for beams 3 and 4 a distance of “0.229” ft. 

 

61) Again, the steps can be combined with the pier cap at any point or left as separate solids.   

62) Right-click anywhere on the screen and select, “Displayset Clear”. 

63) You may delete the reference lines placed at the top of the pier caps. 
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	Chapter	10	–	Abutments	
1) Open the Generative Component version of OpenBridge Modeler. 

2) Map to the location of your 3D model, “0510077 OBM Bridge.dgn”, and open. 

3) From within the “OpenBridge Modeler” workflow, go to the “Utilities” tab and select “Import GCP File” within 

the “GC” group. 

 

4) Map to the file “IL_IntegralAbutment.gcp” within the IDOT configuration. 

 
 

5) Select the file and click “Open”. 
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6) In the “GC” group, select “Variable Mapping”. 

 

7) Select “IL_IntegralAbut”, then “Apply”. 

  

8) Select the top dropdown that appears empty. 

 

9) Select “ByDefault”. 
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10) Select the “User Options” dropdown in the “baseCS” row and select “Placement”. 

 

11) Select “OK”. 

12) From within the “OpenBridge Modeler” workflow “Home” tab, select “Place Custom Abutment”. 

 

13) Ensure that the “Cell” attached is the IL_IntegralAbut.  If not, select it by clicking on the three dots on the right 

side of the “Cell” row. 

 

  



Illinois Department of Transportation 
Technology Policy and Support – CADD Support Unit 

 

OpenBridge Modeler CONNECT Edition 
Chapter 10 – Abutments – EXERCISES 

Page 90 of 149 

 

14) If necessary, select “IL_IntegralAbut” and then “OK” to return to the “Place Custom Abutment” tool. 

 

15) Edit the other values in the “Place Custom Abutment” dialog as shown below: 
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16) Select “SupportLine1” and reset.  

17) With the “Place Custom Abutment” command still active, change the data in the dialog as shown below: 

 

18) Select “SupportLine4” and reset. 

19) Reset once more to exit the “Place Custom Abutment” command. 

20) Now that the Generative Component abutments have been placed, the variables need to be modified. 

21) Change to the “Computational Design” workflow. 
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22) In the “Model” tab, select the “Graph” command in the “Tools” group. 

 

23) Regardless of what the software names the abutment, you can identify it by hovering over the non-greyed boxes 

in the “Graph” dialog.  It is appearing here as “Abutment1”. 

 

24) Double-click on the box corresponding to your West abutment. 

  



Illinois Department of Transportation 
Technology Policy and Support – CADD Support Unit 

 

Page 93 of 149 OpenBridge Modeler CONNECT Edition 
Chapter 10 – Abutments – EXERCISES 

 

25) Within the “Node Properties” dialog that pops up, toggle the “Hold Changes Until Applied” button in the upper 

left-hand corner.  This will hold the variable changes until it is toggled again; otherwise, it will change each time 

a value is changed which takes a few seconds for each revised value. 
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26) Change the values as shown below and click on the green checkmark at the top of the dialog once these changes 

have been completed. 

 

27) Click on the green checkmark. 
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28) In the “Graph” dialog, double-click on the other abutment and in the same manner, revise the values as shown 

below.  Click on the green checkmark at the top of the dialog once these changes have been completed. 

 

29) Close the “Node Properties” dialog, then the “Graph” dialog. 

30) Exit “OpenBridge Modeler Generative Components”. 

Note:  Gct file(s) are created whenever Generative Components are placed and/or modified.  If changes are made to the 

abutments in the future, a new gct will be created for each editing session.  The most recent is the only one that is 

required and has “(Newest)” at the end of the filename. 
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If you use ProjectWise, the workflow will be slightly different.  You must locate the gct once it is created (upon 

completion of the placement and modification) and copy it from the pw_work folder to the same location as your dgn in 

ProjectWise.  Bentley is working on making the process a little more user-friendly for future versions of OBM. 
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Chapter	11	–	Concrete	Diaphragms	
1) Open the file “0510077 OBM Bridge.dgn” in OpenBridge Modeler. 

2) From the “Level Display”, make the “Default” level current. 

3) Make sure that the active design file is selected in the file hierarchy as shown below: 

 
 
4) Right click within the blue area listing the levels and select “All Off”. 

 

5) Select “Apply to Open Views” (only necessary if you have multiple views open). 
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6) This turns off all levels in the active file except for the “Default” level.  (Note that this does not affect the levels 

in any reference files). 

7) If desired, turn off all levels in the “DecorationSpace” model.  This is where OBM places its reference lines and 

text that are at an elevation of 0.00 ft. 

 

8) Make a level active that will stand out, such as “BR-OBM_FC_ConstructionLine”.  The level can be changed later 

to “BR-OBM_Diaphragm_Concrete”. 

9) In an Isometric (or dynamic) view, use the “Place Block” tool to place shapes at the plane that is 2” below the 

low beam seats for each of the seats.  As an alternate, you could use the “Place Shape” tool.  (You should place 

six rectangular shapes at the same elevation). 
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10) Move all six shapes such that they are at the actual seat elevations. 

 

11) In the “Modeling” workflow, under the “Solids” tab and in the “Create Solids” group, select “Extrude”. 

 

12) Using the below settings, extrude all six rectangular shapes (This will cause the solids to extend above the 

bottom of the extruded deck, but below the top). 
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13) In the “Modify Features” group, select “Unite”. 

 

14) Verify the settings match below: 

 

15) Select the first newly created solid, then the adjacent solid. 

16) While holding down the “Ctrl” key on the keyboard, select the remaining four solids. 

17) Once all are selected, release the “Ctrl” key and accept. 

18) At the minimum, turn on the level “BR-OBM_Deck”. 

19) From within an Isometric or dynamic view, draw a line from the curb line at the North end of the deck to the 

centerline and another from the centerline to the curb line at the South end of the deck.  (These will be used to 

define the approach ledge). 
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20) Turn the level, “BR-OBM_Deck” off. 

21) Extend the lines from the curb line by a fixed distance beyond the edge of deck (use 3 ft) at each side. 
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22) Using the “Element Selection” tool, select the two lines. 

 

23) Pick the “Move” command and select a data point anywhere on the screen. 

24) Type “F” to rotate the AccuDraw compass. 

25) Move the cursor such that it locks to the negative “Z” direction. 

 

26) Type “1.25” and then click a data point. 
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27) While the lines are still selected, copy them up an arbitrary distance (We’ll use 3.0 ft). 

 

28) Draw lines connecting these lines in order to create a closed shape. 

 

29) In the “Drawing” workflow within the “Groups” group, select the “Create Complex Shape”. 
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30) Verify the settings are as set as below and select each of the six lines in sequence and then accept. 

 

31) In the “Modeling” workflow under the “Solids” tab, select “Extrude” from within the “Create Solids” group. 

 

32) With the setting below, extrude the shape previously created away from the bridge. 
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33) In the “Modify Feature” group, select “Trim Solid”. 

 

34) With the “Trim Solid” settings as shown below, select the diaphragm solid, select the solid just created, then 

accept. 
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35) Turn the level, “BR-OBM_Deck” on. 

36) Select the “Trim Solid” command again with the settings shown below. 

 

37) Select the diaphragm first, the deck second, then accept. 

38) Using the “View Rotation” tool in one of your open views, change the “Method” to “Dynamic”. 

 

39) Select the “Sphere”  

40) Left click and hold the crosshair and drag so that it snaps to a point on the model. 
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41) Click and drag inside of the sphere to rotate the view about the center of the sphere.  (You will actively see the 

view rotate). 

 

42) Rotate the view such that you are looking at the front face of the West abutment so you can see the bottom 

edge of the front face of the diaphragm. 

 

43) Within the “Modeling” workflow, select the “Chamfer” command that is in the “Features” group. 
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44) Set “Method” to “Equal Distance” and the “Distance” to “0.167”. 

 

45) Select the first edge and then accept.  (Make sure that the chamfer is behaving as it should before accepting).  

You should work from the middle of the abutment to the outside in both directions for the chamfers to appear 

correctly. 

 

46) Repeat for the remaining steps. 

47) Repeat steps 8 thru 45 for the East abutment. 

48) The next steps are for creating the 6” chamfer between the bottom of the deck and the front of the diaphragms 

between the beams. 

49) Select another level, such as “BR_Constructions_Line” 
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50) Looking at the front of an abutment and diaphragm, draw a “SmartLine” along the intersection between the 

bottom of the deck and the front of the diaphragm. 
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51) Right click and hold after selecting either the diaphragm or the deck and pick “Turn Level Off by Element”. 

 

52) Repeat so that both the deck and the diaphragm levels are turned off. 

 

53) Select the “Place Line” command and snap to the endpoint of one of the lines just drawn. 
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54) Type “F” to rotate the AccuDraw compass to a front view setting. 

 

55) With the line locked in the negative “Z” direction, key in “0.5” and accept. 

 

56) Draw a line from one of the two lines defining the path for the chamfer using the “Perpendicular” snap. 

57) Type “T” to rotate the AccuDraw compass to the top view. 

 

58) With the tentative line locked in the “X” direction, type “0.5” and hit “Enter”. 
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59) Move the line to the endpoint of the line defining the chamfer path. 

 

60) Draw a line connecting the two additional lines to create the hypotenuse of a triangle. 

 

61) Using the “Extend Line” tool, extend the hypotenuse 2” in both directions. 

 

62) Move the horizontal and vertical 6” lines to the ends of the hypotenuse. 
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63) Using the “Trim to Intersection” tool, close the triangle. 

 

64) Convert the triangle into a single entity by using the “Create Complex Shape” command. 

65) Draw a circle, sphere, or any temporary element at the endpoint of the chamfer path. 

 

66) Turn off all levels except “BR-OBM_GirderSteel” and the active level. 

67) Change your actual view rotation to “Top”. 

68) Using the “Extend Line” tool, extend the Smart Line defining the chamfer path to the inside face of the fascia 

web at each end.  This line will define the path that we will be extruding our shape along. 
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69) Dynamically rotate the view so you can see the triangle that you previously created. 

 

 

70) Using the “Element Selection” tool, select the triangle and move to the endpoint of the chamfer path. 

 

71) From within the “Modeling” workflow, under the “Solids” tab, select “Extrude Along”. 
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72) Change the “Alignment” to “Parallel”. 

 

73) Select the path (SmartLine). 

 

74) Select the triangle which is to be extruded along the path. 
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75) Accept the tentative solid if it appears correctly. 

 

76) Turn on the levels for the deck and the diaphragm. 
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77) Pick the “Unite” tool in the “Modeling” workflow under the “Solids” tab, within the “Modify Features” group. 

 

78) With the setting as shown, select the deck and then the chamfer solid. 

 

79) While holding down the “Ctrl” key, select the diaphragm (Note that they need to be selected in that sequence in 

order for the resulting solid to take on the properties of the slab). 

80) Left click to accept. 

 

81) Repeat steps 48 through 80 for the other diaphragm. 
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82) Turn all levels back on (Don’t forget the DecorationSpace levels). 

83) If desired, select a “Display Style” such as “Illustration:  Ignore Lighting” and dynamically rotate the view. 
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Chapter	12	–	Approach	Slabs	
  We will be using the “Place Deck” command to place part of the approach slabs.  The Approach Slab tools will be used 

to place the ends of the approach slabs as well as the sleeper slabs.  We will then use the “Place Barrier” command for 

the constant slope parapets on the approaches nearest to the abutments.  To do this, we need to first place additional 

support lines and approach reference lines defining the starting and stopping points of the two sections.  We then must 

copy and/or modify the deck templates before they can be used in our project. 

1) In the “OpenBridge Modeler” workflow, select the “Place”, then “Parallel” command in the “SupportLine” 

group. 

 

2) Ensure that the “Feature Definition” is set to “SupportLine”, and the “Offset” is set to “-14.000” ft. 
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3) Pick the West Support Line and ensure that the new support line is placed away from the bridge. 

 

4) Data point to accept. 
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5) In the “Approach Slab” group, select “Place Approach Ref Line”. 

 

6) Adjust the values in the toolbox as follows: 
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7) Left click on the screen to accept the tentative location. 

 

8) Left click again to accept the reference line length. 

 

9) Reset to end the command. 
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10) The approach reference line along with the corresponding station will appear. 

 

11) Repeat steps 1 through 10 for the East end.  (Note that you will have to change the “Location” to “End” within 

the “Place Approach Ref Line”). 
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12) Click on the “Utilities” tab and then “Decks” within the “Libraries” group. 

 

13) Expand the “Illinois DOT” group of templates and ensure that you have the following two templates: 

 

14) Copy and move the two templates to the previously created “051-0077” folder. 

 

15) Change the shoulder widths to 6.000 ft for both of the approach slab templates as was previously done for the 

deck template. 

16) Close the Template Creation dialog.  
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17) Select “SleeperSlab” within the “Libraries” group. 

 

18) Expand “Sleeper Slab” and “Illinois”, highlighting “Illinois Sleeper”. 

19) Select “Edit” towards the top of the dialog box. 

 

20) Edit the values in the “Sleeper Slab Templates” dialog as follows and select “OK”. 
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21) Close the dialog. 

  Because of the way OpenBridge Modeler treats the approach slabs, the “Place Approach Slab” tool cannot place 

two different sections across the length of our intended approach slab.  This is why we have both an additional 

Support Line as well as an Approach Reference Line.  We will first place a deck from the abutment to the end of 

where our constant slope parapet ends.  We then can use the “Place Approach Slab” and “Place Sleeper Slab” tools 

to complete the approach slab itself.  This is then followed by the “Place Barrier” tool which is what was used for 

the deck of the bridge. 

22) From the “Superstructure” group under the “Home” tab of the “OpenBridge Modeler” workflow, select “Place 

Deck”. 

 

23) Edit the values in the “Place Deck” dialog box as shown below. 
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24) Select the “…” to select the “Template Name”. 

25) Select the template, “Approach Slab near Abutment” from the “051-0077” group of templates. 

 

26) Select the “SupportLine5”, then “SupportLine1”, then data point to accept with no constraints. 

 

27) From the “Approach Slab” group, select “Place Approach Slab”. 
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28) Complete the “Place Approach Slab” dialog with the data as shown with the “Approach Slab near Approach 

Footing” in the “051-0077” template group . 

 

29) Selecting a data point places the approach slab. 

30) From the “Approach Slab” group, select “Place Sleeper Slab”. 
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31) Complete the “Place Sleeper Slab” dialog as follows: 

 

32) Select data point twice to place the sleeper slab. 

33) For placement of the first part of the East approach, select “Place Deck” from the “Superstructure” group. 
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34) Edit the values in the “Place Deck” dialog box as shown below with the template, “Approach Slab near 

Abutment”. 
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35) Select the “SupportLine4”, then “SupportLine6”, then data point to accept with no constraints. 

 

36) From the “Approach Slab” group, select “Place Approach Slab”. 
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37) Complete the “Place Approach Slab” dialog with the data as shown with the “Approach Slab near Approach 

Footing” set as the template.  The only thing that should need to be changed is the “Location” to “End”. 

 

38) Selecting a data point places the approach slab. 

39) From the “Approach Slab” group, select “Place Sleeper Slab”. 
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40) Complete the “Place Sleeper Slab” dialog as shown below.  Note that the “Placement of Start Sleeper Slab” will 

be toggled off and the “Placement of End Sleeper Slab” will be toggled on. 

 

41) Select data point twice to place the sleeper slab. 
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42) Select the “Place Barrier” command in the “Accessory” group. 

 

43) For the template, select the “39” Constant Slope Parapet LT” and set the other values of the “Place Barrier” 

dialog as shown below: 
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44) Select the half of the approach slab nearest the West abutment. 

 

45) Reset, then select a data point. 

46) Click on “Select Guideline from List”. 
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47) Zoom in on the left side to identify the curb line for the left parapet. 

 

48) Select “P_12” and then “OK”. 

 

49) Select “OK” again. 

 

50) Select the “Place Barrier” command again. 

51) With the dialog settings unchanged, select the approach slab section nearest to the East abutment. 
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52) Reset and then data point. 

53) Select “P_12” again from the “Select Guideline from List” dialog and then “OK”. 

54) Select “OK” again. 

55) Repeat steps 42 through 54 to place the right barrier at the East and West ends of the bridge.  Make sure that 

you change the barrier template to “39” Constant Slope Parapet RT” and use the guideline point of “P2”. 
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Chapter	13	–	Parapet	&	Curb	Tapers,		DTM	
1) To create the tapers at the ends of the parapets and curbs, we will be creating solids at each taper location and 

subtracting them out from the OBM solids. 

2) Turn off all levels except for “BR-OBM_Deck” and “BR-OBM_Barriers”. 

3) Using the dynamic rotation tool, rotate the view so that you can see the top and end of the Southwest parapet. 

 

4) Make an unused level active, such as “BR-OBM_Auxiliary”. 

5) In the Southwest corner of the bridge, draw a line along the top of the Southwest parapet end. 

 

6) Using the “Copy Parallel” command, enter the distance of “2.0” and select the line just drawn. 
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7) Type “T” on the keyboard to rotate the AccuDraw compass to the top view settings. 

 

8) Datapoint towards the bridge to copy the line 2.0 ft. 

 

9) Draw a line from the midpoint of the new line down an arbitrary distance to get it to end below the plane of the 

top of the parapet (Type “F” to rotate the AccuDraw compass). 
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10) Within the “Modeling” workflow, under the “Surfaces” tab, select “Compute Surface from Intersections”. 

 

11) Select the vertical line and the approach slab parapet solid.  A point will be placed anywhere the vertical line 

intersects the solid. 

 

12) Delete the vertical line that you just created. 
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13)  Move the horizontal line down, snapping the midpoint of the line to the point. 

 

14) Select and move the original line down 5” (Remember to type “F” for the AccuDraw compass). 

 

15) Using the “Extend” command, extend both lines 1.0 ft in both directions. 

 

16) Draw lines connecting the two modified lines. 
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17) Extend both of those lines 1.0 ft also. 

 

18) Move the original two lines to the endpoints of the two newest lines. 

 

19) Use the “Create Complex Shape” command to create a closed shape. 

20) In the “Modeling” workflow under the “Solids” tab, select the “Extrude” command. 

 

21) Extrude an arbitrary distance, such as 2.0 ft. 
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22) Select the “Subtract” tool from the “Modify Features (R)” group. 

 

23) Select the barrier first, then the shape we just created, then data point to accept. 

 

24) Repeat to place the remaining three tapers. 
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 (In a similar manner, the tapers for the curbs will be created). 

25) Turn on the level “BR-OBM_Approach_Slab”. 

26) Zoom into an isometric view of the Southeast corner of the bridge, viewing the end of the curb. 

27) Draw a line along the top of the Southeast parapet end. 

 

28) Using the “Copy Parallel” command, enter the distance of “5.0” and select the line just drawn (Type “T” on the 

keyboard to rotate the AccuDraw compass to the top view settings). 

 

29) Draw a line from the midpoint of the new line down an arbitrary distance to get it to end below the plane of the 

top of the parapet (Type “F” to rotate the AccuDraw compass). 
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30) Within the “Modeling” workflow, under the “Surfaces” tab, select “Compute Surface from Intersections”.  (Note 

that if the command will not allow you to select the approach slab, you will need to convert it to a Smart Solid.  

This is done by the “Convert to Solid” command in the “Solid Utilities” group in the “Solids” tab of the 

“Modeling” workflow). 

 

31) Select the vertical line and the approach slab curb.  A point will be placed anywhere the vertical line intersects 

the solid. 

 

32) Delete the vertical line that you just created. 

 

  



Illinois Department of Transportation 
Technology Policy and Support – CADD Support Unit 

 

OpenBridge Modeler CONNECT Edition 
Chapter 13 – Parapet & Curb Tapers, DTM – EXERCISES 

Page 146 of 149 

 

33) Move the horizontal line down, snapping the midpoint of the line to the point. 

 

34) Select and move the original line down 2” (Remember to type “F” for the AccuDraw compass). 

 

35) Using the “Extend” command, extend both lines 1.0 ft in both directions. 
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36) Draw lines connecting the two modified lines. 

 

37) Extend both of those lines 1.0 ft also. 

 

38) Move the original two lines to the endpoints of the two newest lines. 

 

39) Use the “Create Complex Shape” command to create a closed shape. 

40) In the “Modeling” workflow under the “Solids” tab, select the “Extrude” command. 
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41) Extrude the shape an arbitrary distance, such as 2.0 ft. 

 

42) Select the “Subtract” tool from the “Modify Features” group. 

 

43) Select the barrier first, then the shape we just created, then data point to accept. 

 

44) Repeat to place the other three tapers. 

45) Remember that if the “Subtract Solids” command will not allow you to select the approach slab, you will need to 

convert it to a Smart Solid.  This is done by the “Convert to Solid” command in the “Solid Utilities” group in the 

“Solids” tab of the “Modeling” workflow). 
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46) For the final step of the exercise, using the Reference dialog, attach the model named “Terrain” in the file 

“0510077-OBM DTM.dgn”. 
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